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Editor’s Column
By Jay Castillo

The Journal staff and Pi management have seen the light! You will note from 
the cover and content of this and the last Journal, as well as the programs at the 
General Meetings this spring, that we are focusing on your digital world. Coverage 
of digital devices and related software and how they can affect your lifestyle is 
our main theme. We fully expect this theme to continue as more services and 
upgraded devices are added to the mix.

All of Apple’s latest devices are geared to synchronizing information and making 
processing photos, videos, and messages a lot easier. This will keep you better 
connected to your world and the folks in it. Read how one Pi member, Travis 
Good, uses his digital devices and makes keeping in touch an art form. The article 
is a recap of the April 2011 General Meeting presentation by Travis. The article 
begins on page 10. 

In addition, we bring you a couple of software reviews that will inform you in 
your continuing “going paperless” saga and provide insight on a nifty cataloguing 
application for your books, music, and other treasured possessions. There’s also 
an article on how your iPad 2 might actually be a supercomputer. 

So enjoy your Journal, send us feedback, and remember, if you feel the urge to 
become a published author, we can help!

http://www.wap.org
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See you at the monthly meeting!
By Jay Castillo

I hope. I think I have discerned a trend over the 
past few months toward declining attendance at 
the Pi monthly General Meeting. I certainly see a 

number of regulars who usually attend, and there are 
occasional visitors or new members. But it seems to 
me that we have had up to 50 percent attrition of late. 
In my opinion, those who do attend have an excellent 
experience. We have knowledgeable presenters, with 
interesting subject matter. The presentation style and 
content is professional and well done. Most of our 
presenters are Pi members who fully embrace the Pi 
rubric of “members helping members.” 

We want to ensure that the Pi membership receives 
full measure for their investment of time and 
membership costs. We now stream the question-

and-answer and main presentation segments of the 
General Meeting using Ustream. So, if you can’t attend 
in real life, look in via the Webcast:  
(http://www.ustream.tv/channel/wap-general-meeting). 
In addition, our in-house technical gurus (your 
colleagues) are exploring providing Pi members with 
the video recording via podcast and/or DVD. 

We certainly prefer to have you attend the meetings 
in person, but however you participate, we are glad to 
have you. An additional benefit of personal attendance 
is the opportunity to remain after the General Meeting 
to enjoy the My Mobile Lifestyle Special Interest 
Group. As a bonus, we serve lunch (for a very modest 
donation)! So, join us next meeting, if you can. If you 
can’t, tune into the Webcast, and wave to us.

http://www.ustream.tv/channel/wap-general-meeting
http://www.wap.org
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Quotable Quotes

Smart UPS or  
Surge Protector?*
A Pi member recently sought advice on the Pi’s TCS Forum 
about getting an UPS (Uninterruptible Power Supply).  
The digital messages flowed back and forth until at one 
point when the questioner asked, “Is it safe enough to 
put the laser printer into a separate outlet in the room, or 
does it need its own surge protector?” The quote below cut 
to the core of that issue.

A quote from Lawrence Charters:
“Uh, the two thoughts are not incompatible. A laser printer 
should not share a surge protector with anything and a laser 
printer should not be plugged into the same circuit as your 
computer. In our home, the laser printer is on a different 
floor and different circuit.”

*Source: TCS item #7321  
<http://tcs.wap.org/topic?b=maint&top=7321#7321>

Hot Links!
Mac Start-Up Sequence
If you think that the sights and sounds that appear when you start up your Mac 
computer are there to keep you occupied while you wait to get started on your 
computer tasks, reconsider. These sights and sounds have specific meanings that can 
provide valuable information if there is a boot problem. To find out what happens 
when you start up your Macintosh computer, and what it tells you, check out these 
websites:
http://www.tuaw.com/2010/10/22/mac-101-whats-happening-when-your-mac-is-start-
ing-up/

http://www.peachpit.com/guideontent.aspx?g=mac&seqNum=59

Is There An App for That?
Here are two sites that are handy places to search for iOS apps for all your mobile 
devices. There are many ways to efficiently search for your particular needs and wants. 
Check them often, for there are paid apps that are offered for free for a limited time.
http://appadvice.com/appnn

http://appshopper.com/

“I Feel the Need…the Need for Speed!”
Apple has introduced their new iMacs, and the emphasis seems to be on speed, with 
quad-core processors (Sandy Bridge) in each model, up to three-times faster graphics, 
and the Thunderbolt data port. Check out the Apple site for the buzz.
http://www.apple.com/imac/

You can see the results of benchmark testing for the actual performance improvements 
(or not) compared to older iMacs and the 2010 6-core Westmere Mac Pro.

http://www.barefeats.com/imac11b.html

http://www.tuaw.com/2011/05/07/new-imacs-25-percent-faster-than-previous-
generation/

http://www.tuaw.com/2010/10/22/mac-101-whats-happening-when-your-mac-is-starting-up/
http://www.tuaw.com/2010/10/22/mac-101-whats-happening-when-your-mac-is-starting-up/
http://appadvice.com/appnn
http://appshopper.com/
http://www.apple.com/imac/
http://www.barefeats.com/imac11b.html
http://www.tuaw.com/2011/05/07/new-imacs-25-percent-faster-than-previous-generation/
http://www.tuaw.com/2011/05/07/new-imacs-25-percent-faster-than-previous-generation/
http://www.wap.org
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Pi Elections

Election 2011:  
Meet the Candidates!
Introduction
The five Pi members listed on this page may look famil-
iar, as well they should. All are outgoing members of the 
Board of Directors who have graciously consented to run for 
reelection. Three of the candidates are actively serving on 
the Management Committee — the Pi committee that gets 
things done. Each of these self-nominated individuals is a Pi 
member in good standing, and each has provided valuable 
assistance to the club in one fashion or another. Each has 
exhibited great enthusiasm for the Pi and provided good, 
common-sense direction to keep the club a viable computer 
user group. We are a strong and fiscally sound organization 
due to the willingness of these Directors to participate. Elect 
them to the Board!

Voting Instructions
The voting process is easy and fast, and we have the means 
to provide secure electronic balloting. Click on the below 
link to the Pi Connect page. After logging in, you will be 
taken directly to the voting page. Each nominee’s full 
statement will be available to review before you vote. The 
voting instructions are simple and short. Please, support the 
volunteer efforts of these gracious members and vote them 
onto the Board.

https://connect.wap.org/election/

And the nominees (in alphabetical order) are:

Jay Castillo

Jay is the current Pi President, having served in that position for 
two years. Jay has been actively involved in almost every aspect 
of the club with his latest venture as interim Managing Editor for 
the Journal. Jay has been a stalwart member of the Management 
Committee and he really shone when he spearheaded a strategic 
review process that resulted in the first-ever strategic plan for the 
Pi. Jay is an asset to the Pi and his continued service on the Board 
will greatly benefit the Pi.

Neil Ferguson

Neil was appointed to the Pi Board in December ’08 by a 
unanimous vote of the Board. He was nominated for a Director 
position after serving on the Management Committee for only a 
short period of time, during which he proved to be a dependable, 
self-starter. Neil continues to help with various projects like the 
Afternoon Learners SIG and as a volunteer helper at Clubhouse 
Saturday events. Neil brings a solid, common-sense approach to 
Board matters and deserves reelection.

http://www.wap.org
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Ken Goldman

Ken also joined the Board of Directors by appointment in April 
’09. Ken, although having a full time job, has found extra time 
beyond Board duties. He participated in organizing and obtaining 
the judges for the Pi Photo Contest held last year. In conjunction 
with that project, Ken presented on a photography-related topic 
at a General Meeting and has written articles on the subject 
for the Journal. Ken has proven to be an involved Director and 
volunteer for the Pi. Vote for Ken.

Larry Kerschberg

Larry has contributed greatly to the Pi over the last three years. 
Through his efforts as a professor at GMU we enjoy fine, expense-
free accommodations for our monthly meetings held at the 
university. Larry is an involved and dedicated member of the 
Management Committee and his insights and recommendations 
are all invariably worthy of consideration. The professor is a 
valued member of the Pi’s leadership cadre and he deserves 
another three-year term on the Board.

Richard Orlin

Richard has been on the Pi Board of Directors for a full three-year 
term. Despite full-time work, Richard has consistently provided 
comment and opinion when needed. He is a regular attendee 
of the monthly meeting and can always be counted on to lend a 
hand during those events. Richard has an active interest in the Pi 
and he brings a needed perspective to the Board’s membership. 
Reelect Richard.

Pi Elections

http://www.wap.org
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Sharing My Travels
By Travis Good

Feature Article

When I travel I like to stay in touch with lots of different 
people. I don’t want to share the same things with 
everyone, however, nor communicate with everyone 

with the same frequency. For example, my family needs updates 
from me regularly but they don’t care about the same things as 
my photo buddies. In addition, I communicate in a number of 
different ways: blog, galleries, tweets, Facebook posts, etc. Trying 
to share the right things with the right people at the right time has 
been an overwhelming task, but nowadays it doesn’t have to be. 

This article describes how I share my travels. My goal isn’t to 
have you mimic exactly what I do. Instead, I’m hoping you’ll 
understand my process and apply it to your goals. Only by 
learning about available digital devices, sampling new apps, and 
iterating can you steadily improve your process. In the end, you 
should get big results with little effort.

Selecting Digital Devices
As Apple enthusiasts, it’s tempting to limit the discussion of digital 
devices to OS X and iOS devices. My mix includes an iPhone, an 
iPad, and a MacBook Pro. An iPhone is incredibly convenient and 
small, but it’s not particularly good for typing. The iPad is pretty 
good for typing, and is also remarkably portable and comes with 
an amazing battery life. It doesn’t have the same capability as the 
MacBook Pro, but it is often preferable for travel because of its 
size. While these devices are similar, it’s important to understand 
and leverage their differences. 

In addition to these I rely on two cameras, because photography 
is a big part of what I do. You might have other devices 
depending on your interests. Perhaps your kit will include a 
navigation system if you’re a hiker, or a digital recorder if you’re 

an audio enthusiast. The important thing is to have the right 
devices, to understand them, and to use them correctly in your 
process.

In order to do that, you need first to understand what your goals 
are. I have summarized my sharing goals below. 

I communicate in a 

number of different 

ways: blog, galleries, 

tweets, Facebook 

posts, etc.

My sharing matrix.

http://www.wap.org
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Next, you need to work out how to use your various devices 
to achieve these goals. The sequence of steps I developed is a 
combination of apps and process that I call my workflow. After 
much iterating to optimize my workflow, a little effort produces 
big results. I think of my devices as tools. Some devices, such 
as cameras, GPS devices, and audio recorders, are designed to 
perform specific tasks. Others, such as iPads, MacBooks, and 
iPhones, are designed to be flexible. What separates them is the 
ability to program them through software. The iPad has 65,000 
apps available to it, and the iPhone has 360,000. Programs for 
the Macintosh’s OS X have been written for over a decade. In this 
abundance of apps lie both opportunity and challenge.

The Process: a Small Effort
The process I use for accomplishing my goals is rather simple. The 
steps may even seem mundane. Good! That’s what I’ve strived for. 
Like most people, I’m lazy by nature. I’ve learned that if I have 
to work hard constantly to achieve my sharing goals, then more 
than likely I’ll fail and sharing won’t happen.

So what do I do day in and day out? Simply put, I repeat cycles. 
There are three cycles that together allow me to gather the raw 
materials I need to accomplish my sharing goals.
				  
The first cycle is event-driven, and can occur many times a day 
— whenever I’m inspired by something, or arrive someplace, 
or want to make note of an event. There’s no hard rule; it’s just 
something I feel. I see a road sign that prompts a memory. I enter 
a museum that’s of special interest to me. I arrive at an historic 
destination. The trigger is that it’s important to me and I want to 
share it.

If I’m inspired to share something immediately with my family, 
then I’ll use my iPhone’s Camera app to take a picture and send 
it immediately via email or text. Importantly, what lingers on 
my iPhone is the image I just captured. However, it’s far from 
being a top-quality picture. If I want to take a good picture I’ll use 

my camera, which has built-in GPS that will record the location 
where the picture was taken. If I want to record my significant 
daily activities as they are happening — rough notes for my blog 
entries — I use Gowalla. The building blocks for each entry are: 1) 
a picture; 2) a brief comment; 3) a related URL; and 4) a location 
name. Creating these entries is simple, routine and quick, and the 
results are remarkably useful to me later when I want to share. 
During a day I may create three to ten entries ... painlessly.

The second cycle occurs when I pause and regroup, typically 
at day’s end. The two primary activities involve backing up my 
pictures and writing my journal entry. This is critical to avoiding 
a backlog of work. I try to stay current on my work as much as 
possible, since I know from experience that if the burden gets too 
heavy, the work will likely never get done. Also, by regrouping 
nightly I can share bigger thoughts on a daily basis. 

A nightmare every photographer has is losing pictures, so 
backing up is always a priority. I’ve heard it said that unless an 
image file exists in two places, it doesn’t exist. I copy pictures 
from my camera memory cards onto my iPad using the Camera 
Connection Kit that allows me to import files into my Photos app. 
To transfer pictures from my iPhone I use the Transfer app. When 
done, I have two copies of each picture

Once my pictures are backed up and I’ve selected a few to 
represent the day, it’s time to write a draft of my day’s activities 
using my notes from Gowalla. For this I use an iPad app called 
Chronicle, where I record descriptions of the day and include 
selected pictures. Every entry is tied to a specific calendar date so 
over the span of my travels I accumulate drafts of my eventual 
blog entries. By the time I’ve finished this task I’m usually beat 
but feeling satisfied, because I’ll have kept current with my work. 

My third cycle occurs when I finally get home. Even though I’ve 
kept current while traveling, I still have plenty of work to do. 
Since neither Aperture nor iWeb is available on the iPad, I have to 

Feature Article

http://www.wap.org
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process my pictures and publish my blog once I get 
back to my Mac. While I used to carry my Mac when I 
traveled, I’ve chosen not to any more because I found 
that carrying it was weighing me down. The MacBook 
Air could be a solution to this but I haven’t bought one 
... yet.

With hundreds of pictures from every trip, I’d be lost if 
I didn’t use a tool like Aperture to organize my images. 
When I import them, I tag them with key words, I rate 
them, I perform lots of edits, and I back them up. 
It’s all quite efficient and the results make it possible 
for me to easily find pictures I want, which is critical 
to sharing them. It’s also at this stage that I prepare 
pictures for my blog.

For the most important and comprehensive 
documenting of my travels, I use iWeb. This is Apple’s 
blog-publishing platform that brings together the 
entire iLife suite and allows me to build my site: 
www.goodpursuits.com. My pictures are ready from 
Aperture and my text is ready from Chronicle, so I just 
need to assemble the final version of my travels using 
iWeb. This is my most comprehensive effort and my 
permanent record. It’s a lot of work but when I’m 
done I can close the chapter on my trip.

The Big Results
Now that I’ve described the processes I go through, I’ll 
show you how I achieve my sharing goals with little 
extra effort. The big results come through automation 
within key apps.

Gowalla is my note-taking tool but it also can be used 
to push my information to a few sharing services. 
I choose to use three of the services (see Figure 1). 
Twitter is where people can follow me as I visit places. 

Foursquare is a check-in game where a community 
of travelers competes for badges and keeps tabs on 
one another. Tumblr is a blogging service where I 
post pictures in real time so I can point people to 
them. While Facebook is another service available 
in Gowalla, I choose not to use it, as it feels like over-
sharing. Though I’ve not mentioned it previously, 
every Gowalla post is also published on Gowalla.com 
for my later reference. 

Showing pictures to people face-to-face is another 
important dimension of sharing. After importing to 
the iPad Photos app I’m able to share small, medium, 
or large versions of my pictures. I can push images to 
MobileMe galleries from where postcard-sized versions 
of my pictures can be shown on my iPhone Gallery 
app. The Picture Frame app turns my iPad into a 10-
inch display for photo slideshows. Lastly, via Apple TV, 
I can send pictures from my iPad to a big-screen TV for 
sharing with an audience. 

Chronicle also has capabilities that allow me to send 
my daily drafts to others. If I’m anxious to share the 
details of my day in words and pictures, Chronicle 
allows me to send the full blog entry via email. This is 
especially powerful when combined with the service 
Posterous, which will turn emails into blog entries. 
As backup of my work and as a place for my wife to 
preview/edit my drafts, it’s a handy option to have. 

Aperture has sharing capabilities also. The ones I 
use are shown in Figure 2. While I don’t choose to 
share lots of details through Facebook, I do enjoy 
maintaining certain photo galleries and Aperture 
makes this painless. Since all my pictures are tagged 
with location information, I like to post galleries of 
pictures I’m particularly proud of on Flickr to share 

Figure 1: Ways to share with Gowalla.

Feature Article

http://www.goodpursuits.com
http://twitter.com/%23!/TravisGood
https://foursquare.com/travisgood/history
http://travisgood.tumblr.com/
http://www.facebook.com/travis.good
http://gowalla.com/travisgood
http://goodpursuits.posterous.com/
http://www.facebook.com/travis.good?sk=photos
http://www.flickr.com/photos/goodpursuits/
http://www.wap.org
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with fellow enthusiasts. The MobileMe button is another way to 
get images into galleries for showing pictures on my iPad, iPhone, 
AppleTV, etc. These are only three of Aperture’s sharing services. 
There are many more. 

So there you have it: the current version of how I share pictures 
and stories of my travels with others. It’s important to note that I 
was able to arrive at this workflow only through “app snacking,” 
the constant sampling of new apps. For me, app snacking is an 
ongoing activity, and so likely by the time this article goes to press 
I’ll have moved on to new apps and new processes. My goal is to 
continuously improve my workflow.

Take from this what you can, but remember, this is not one-size-
fits-all. Adjust my workflow to your needs. We live in an amazing 
time where technology can empower us to do more than ever 
before or it can enslave us. I choose to harness it and steer it to 
serve me. 

No doubt you too have a digital lifestyle story to share. If so, then 
why not contact president@wap.org and suggest an article you’d 
like to write, a story you’d like to present, or a SIG theme you’d 
like to sponsor. We’re all in this to learn...and to share. Figure 2: Ways to share with Aperture.

We live in an amazing time where 

technology can empower us to do more 

than ever before or it can enslave us.

Feature Article

http://gallery.me.com/travisgood
mailto:president@wap.org
http://www.wap.org
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Mariner Software’s Paperless for Mac OS X
By Al Lubarsky

The digital life articles in the March-April Journal 
included one by Neil McNamara on going 
paperless at home. It was especially relevant to 

me, since the workflow he described roughly equates 
to mine over the past several years. I’m a Portable 
Document Format (pdf) pack rat, too. Everything I find 

on the Internet that I think might be worth reading 
later or might be useful for some other purpose I print 
to a pdf rather than to paper. The same applies to 
all on-line bills, invoices, delivery schedules, receipts, 
RMAs, and so on. In addition, any mail I want to save I 
run through my scanner (originally a Fujitsu ScanSnap 
500M, since replaced with the four-digit series). The 
scanner’s best feature is its high quality automatic 
document feeder, that lets me create long pdfs, 
sometimes nine- or ten-page ones, from a single pass 
through the scanner.

Neil McNamara stores his pdf files and retrieves 
whatever he might need easily — and at no additional 
cost — using the Mac OS X Finder. Is this the best 
way? The folks at Mariner Software obviously don’t 
think so, since they have set $49.95 as the price for 
their Paperless application, which allows you to store 
and retrieve your digital files.When the kindly Journal 
Editor offered a copy of Paperless (Version 2.0.3 is 
current) to the lucky winner of his lottery in exchange 
for a review, I entered. So now I’ve tried Paperless, 
and perhaps this commentary on the application will 
convince you to do likewise — or not. 

Getting Started
Setting up the application is simple. Download the 
roughly 20MB disk image, drag the application to 
the Applications folder, and start using it courtesy 
of Mariner’s free 30-day, full-featured trial period. 
Mariner has partnered with Fujitsu and recommends 
the ScanSnap line of scanners, but the application 

will work with any Twain -compliant scanner, and 
also, according to the Mariner Web site, with just 
about any other scanner using Apple’s Image Capture 
method. (See Figure 1). ScanSnap Manager, included 
with the Fujitsu models, allows for the selection of 
any application to receive scans; Paperless will appear 
on that list, along with items such as Adobe Reader, 
Preview, and whatever other applications are available 
on your Mac for accepting scanner outputs. Obviously, 
if Paperless is selected prior to performing a scan, a 
copy of the pdf will be placed into a Paperless library, 
which will also be opened for your attention and 
action. That’s about it for the setup mechanics. 

When opening Paperless for the first time, the 
application offers to copy all existing pdfs from the 
Documents folder into a Library, and offers to pre-
populate its Categories. Yes or No? Yogi Berra knew 
what to do in these situations — “When you get to a 
fork in the road, take it” — so I followed his lead. Ten 
minutes later, Paperless had finished copying — not 
moving — 1185 pdf’s to its default Library, and had 
also told me, through a series of error messages, that 
seven pdf’s were defective in some way and couldn’t 
be copied. (Of course, I still had several hundred other 
pdfs in file folders stored on the Desktop.) Some of the 
default Categories Paperless sets up are helpful; many 
may not be fully applicable to non-business users. 

Advantages and Disadvantages
At this point, it is probably time to consider — or 
reconsider — the advantages of Paperless over Finder. 

Figure 1. Paperless works with just about any scanner. 
Just select the one you want the application to use.

Software Tutorial

Go Paperless!
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My current practice — without Paperless — is to 
place all scanned documents (as pdfs ) into a single 
folder. ScanSnap Manager assigns a sequential 14-digit 
number to each batch of scans. When I have finished 
scanning, I replace the sequential number with a 
more descriptive title and use the Save As command 
to select a file location for the new file. Thus, I have 
two copies stored: one by scanned date with sequence 
number, and another at a location I have selected. 
Pretty simple, but not well structured, since my rules 
for where to place new items aren’t well defined. 
Moreover, there is no simple way to extract data from 
within the documents.

Paperless, as far as I can determine, replaces this hit-
or-miss filing system with a much more structured 
one. Libraries and collections can be set up and 
defined, somewhat like it is done in iPhoto or iTunes. 
A predetermined list of categories and sub-categories 
is included, and additional ones may be user-defined. 
Smart collections are also possible. In addition, 
Paperless contains a text-reading feature that will 
attempt to read and classify the pdf’s contents, and 
a calculator function to provide totals, balances, etc. 
and allow their graphic display. However, there is 
no user manual for this Paperless version. The Help 
menu is somewhat helpful, but the on-line video 
demonstrations and FAQs are less so. You’ll need to 
have some basic concept of what you’d like Paperless 
to accomplish without benefit of many specific ideas 
from Mariner — about the equivalent of a new Mac 
user setting up the content for iPhoto’s Libraries, 
Events and Albums, perhaps?

First, I set up a new Library and had Paperless copy 
418 pdfs from the Payments folder on my Desktop. 
The 418 pdfs were 66.5 MB; the new Library consisted 

of an item of 119 MB. The pdf reader had tried to 
place the correct category and payment amount into 
the database labels for each item, but with limited 
success. (See Figure 2.) My rough estimate is that 
with practice, and using the thumbnail views of each 
document as provided by Paperless, I might be able 
to better identify and correct each item in about one 
minute. I would want to be especially careful with the 
numbers, since at least one payment was translated 
incorrectly by a factor of a thousand. (Full disclosure: 
after struggling with consumer-level OCR products for 

Figure 2. Here is a part of the (non-corrected) listing Paperless created when it imported my 418 receipts.

35 or so years, I tend to be strongly biased against 
trusting them for any serious purposes.) Correcting 
the first few documents took almost two minutes 
each, mainly due to the small images in the Paperless 
viewer window. 

The idea of spending 30 to 40 hours to straighten out 
my “filing system” for the 2000+ pdf files I already 
have, to conform to the structure that Paperless uses, 
is not of interest to me. This is both because of my 
personal taste for such tasks, and my assessment 

Software Tutorial
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Mariner Software’s Paperless for Mac OS X
Continued from previous page

that I am unlikely to spend that amount of time over 
the next several years tracking down errant pdfs. Of 
course, your tolerance for the task and assessment of 
the time you are likely to spend searching your pdf 
collection may be different. 

New scans are a different story. For them, using the 
Fujitsu (and possibly other brand) scanners, Paperless 
presents a reasonably attractive alternative to Finder. 
Once set up with customized categories, filing 
becomes a more structured experience and perhaps 
no more time consuming than using Finder. One 
problem remains for those of us who choose to scan 
only periodically and like to stack a fistful of bills (or 
stock dividend statements) in the automatic document 
feeder: there is still no simple way to handle multi-
sheet scans of diverse paperwork. That feature alone 
could entice me to start again with Paperless and 
incrementally do something with my existing files. 

Conclusion
For those who are now considering the use of a 
scanner-based filing system to get rid of paper 
files, and who do not have a large set of legacy 
pdfs to handle, Paperless should be given serious 
consideration—especially if your scanner purchase 
includes a free or deeply discounted copy.

Paperless for Mac OS X, by Mariner Software, is 
available for $49.95 from Mariner at  
www.marinersoftware.com, and for slightly less 
from various retailers listed on the Mariner Web site. 
The latest version, Version 2.0.3, requires an Intel 
processor.

Pi Membership Benefit #4
Member Assistance
The Pi has many programs in place to accomplish its mission of “Members Helping Members.” There are 
formal events, mechanisms for putting members in touch with helpful volunteers, and opportunities to 
get questions answered in an informal setting. Take a gander at the list below and see if anything listed 
there can meet your need for computing assistance.

•	Clubhouse Saturday - On select Saturdays, Pi volunteers make themselves available at the Pi Clubhouse 
to answer questions, perform minor hardware repairs or upgrades, and provide tutorial help with Mac 
OS X or other Apple applications.

•	PiChat – This service uses iChat running on our Pi servers to allow members to contact Pi volunteers for 
help. A key advantage of using iChat is the ability to screen share so the member’s problem or question 
can be addressed directly on their Mac at home. Volunteers can be reached at predetermined times 
like during Clubhouse Saturdays, at other prearranged times, or anytime the volunteer is displaying the 
PiChat icon in their iChat Buddy List.

•	Pi TCS Forum – The Pi has hosted a discussion forum for decades and there is a treasure trove of 
information available in it. With a recent upgrade in search capability, finding an answer to your 
question is much easier now. Many members monitor the TCS (TeleCommunication System) Forums and 
the answers are generally fast and to the point. The expertise of our members shines in this venue. 

•	General Meeting Q&A – Every General Meeting starts with a half-hour period of questions and answers. 
This is typically led by Lawrence Charters, a renowned expert in all that is Mac.

•	Pi Hotline list – This is a list of Pi members who have graciously agreed to take questions over the 
phone. The service is accessible through the Pi Connect page.

The above list is not all-inclusive. You can, of course, get help via informal conversations with other Pi 
members at our various meetings and Pi events. Many members are members because they enjoy sharing 
their experience and expertise. Don’t be a stranger; become involved, learn, and share!

Pi Quick Notes
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Preparing for Lion: Find Your PowerPC Applications
©2011 Matt Newburg

The article below is reprinted from an entry on the TidBITS Web site and used with permission of  the author, Matt Newburg.  
The permanent URL for this article is: http://tidbits.com/article/12156.

Software Tutorial

The history of Mac development is not like a 
plant that grows and branches and produces 
leaves and flowers. It’s more like a series of 

rubber bands that get stretched to the breaking 
point and eventually snap. The 68000 processor was 
dropped; then the whole 68K processor family was 
superseded by Macs using PowerPC processors. Snap! 
When Mac OS X came along, all applications had to be 
rewritten, except for the lucky ones that could operate 
correctly inside the Classic emulator. Snap! When Macs 
started relying on Intel processors, support for Classic 
was dropped. Snap!

Now it was PowerPC that was emulated, using Rosetta. 
In Snow Leopard, the first Intel-only version of Mac 
OS X, Rosetta wasn’t installed by default; it would be 
downloaded and installed automatically the first time 
a PowerPC application launched, but the hand was 
already writing its ominous message on the wall. The 
rumor, which has become as loud as a roar, is that 
Mac OS X Lion will not support Rosetta. Snap!

No bad thing will happen to your Mac the day Lion 
goes final. Your current hardware won’t refuse 
to boot. Your current system won’t stop working. 
Your favorite applications will still be your favorite 
applications. But suppose, just for the sake of 
argument, that you become interested in upgrading 
to Lion. And suppose, for the sake of even further 

argument, that Lion lacks Rosetta. What might the loss 
of Rosetta mean to you?

To find out, you need to know what PowerPC-only 
applications you currently depend on. The easiest 

way to learn that is through System Profiler. This 
application resides in your /Application/Utilities 
folder, but there’s a shortcut; choose About This Mac 
from the Apple menu, and when the dialog appears 
describing your system and hardware, click the More 

http://db.tidbits.com/author/Joe Kissell
http://www.wap.org
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Info button to launch System Profiler. Even faster, 
Option-click the Apple menu and choose System 
Profiler directly.

System Profiler displays its information in three 
categories, listed in a pane down the right side of 
its window: Hardware, Network, and Software. For 
the fullest display of categories, choose View > Full 
Profile. Now, under Software (click the triangle to 
open it if necessary), select Applications.

Now go make yourself another espresso from your 
handy-dandy Pavoni Napolitana, because it could take 
a while for anything to appear in the window. System 
Profiler is going to walk through all mounted hard 
disks looking for applications, and if you’re anything 
like me, it’s a long walk (a big disk containing a lot of 
applications). When System Profiler finally finishes, 
your applications will be listed, along with several 
columns of information about them. The column 
you’re most interested in right now is the Kind column 
(you can drag it to the left to move it next to the 
Application Name column, if that makes parsing the 
results easier). It will say one of four things:

[image link] [1]

Classic: These are 68K applications. What are you, 
some kind of sentimental wacko? These applications 
may have run under System 7 or as late as Mac OS 9, 
but under Mac OS X the only way they’ve ever run, 
if they’ve ever run, is in the Classic environment. If 
you’re running Snow Leopard, or even Leopard on 
any Intel-based Mac, there is no Classic. So why do 
you still have them around? Actually, a few of these 
applications are occasionally still important to me, 
and I run them using SheepShaver, as I explained 

in “SheepShaver Brings Classic Mac OS to Snow 
Leopard [2]” (23 October 2009). So far be it from me 
to criticize.

Intel: These are Intel-native applications. They’ll 
probably continue to work reasonably well on Lion, 
though of course there can be glitches caused by 
the introduction of a new system. They are probably 
actively developed, though, so with luck any such 
glitches will be ironed out by their developers.

Universal: These are “universal binaries” that contain 
both PowerPC code and Intel code, so if you’re 
running Snow Leopard, which means you must be 
using an Intel-based Mac, they behave like Intel-native 
applications as far as you’re concerned.

PowerPC: Aha! These are the droids we’re looking for. 
They contain PowerPC code and no Intel code. So if, as 
is commonly expected, Lion doesn’t support Rosetta, 
these applications will be pushing up daisies. They will 
be pining for the fjords. They will have gone to meet 
their maker. They are even now crying out, “Ave Caesar! 
Nos morituri te salutamus!” Which means, roughly (and 
bearing in mind that I have a PhD in Classics and you 
probably don’t): “Stab me in the back! Stab me in the 
head! Farewell, Caesar! Dead dead dead!”

The list of applications presented by System Profiler 
may be very long and intractable. One way to make 
it more tractable is to sort the list: click the Kind 
header at the top of its column. Now your PowerPC 
applications are listed together in alphabetical order. 
If you’d like a more conveniently searchable record 
of this information, you can copy a subset of this list 
as a text file. With the list sorted by Kind, click the 
first PowerPC application to select it, then scroll down 

and Shift-click the last one to select all the PowerPC 
applications in between. Now click in the description 
pane at the bottom of the System Profiler window, 
press Command-A to select all the text, copy, switch to 
your favorite text editor, and paste.

If you’re like me, you’ll find that the way forward isn’t 
quite so gloomy as you may have anticipated. I have 
lots and lots of PowerPC applications, but most of 
them I haven’t used in years. Here’s a quick survey of 
my situation:

I’ll miss Alco Blom’s URL Manager Pro, but in 
anticipation of Rosetta’s loss I’ve already moved that 
data into Safari itself, which turns out to be quite a 
good bookmark manager in its own right. Similarly, 
I’ve moved my data out of Alco’s Web Confidential, 
confiding the exported data to Panorama.

I’ve already explained how I’ve replaced Remember? 
with iCal; see “Freeware Coolness Crushes iCal 
Shortcoming [3]” (4 August 2010).

Solitaire Till Dawn is a big worry. It’s a perennial 
favorite here at TidBITS and among our readers. You 
might like to look at developer Rick Holzgrafe’s blog 
post [4] on its history and his plans; it presents an 
even longer list of snapped rubber bands (he calls 
them dead horses).

Those are the only serious problems on my machine. 
Most of the other PowerPC applications on my 
machine have names I don’t even recognize. A few 
of them are games that I remember enjoying at one 
time, but I suppose I can live without; those sorts of 
games play better on the iPad anyway.

Software Tutorial

Continued on page 29
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The iPad 2 as a Supercomputer?
By Jay Castillo

Hardware Review

According to a recent article in The New York Times (http://bits.
blogs.nytimes.com/2011/05/09/the-ipad-in-your-hand-as-fast-
as-a-supercomputer-of-yore/), a research group at the Oak Ridge 
National Laboratory tested the iPad 2 and determined that it 
performed essentially as fast as the 1985 supercomputer, the 
Cray 2. They used a standard benchmark test for computers, 
the Linpack benchmark, which is a mathematical computation 
involving the performance of a dedicated computer system for 
solving a dense system of linear equations.

There is no strict definition of a supercomputer. Wikipedia defines 
it as “a computer that is at the frontline of current processing 
capacity, particularly speed of calculation.” The Cray 2 was the 
fastest computer in the world from 1985 until 1990. It peaked at 
1.9 Giga-Floating-Point-Operations-Per-Second (GLOPS) (Floating-
point operations are mathematical calculations using scientific 
notation for the numbers). The iPad 2 achieved between 1.5 and 
1.65 GFLOPS in the recent test. 

How do the iPad 2 and the Cray 2 compare?
Figure 1 is a picture showing the Cray 2 Computer and Figure 2 
is a list of its physical characteristics. Note that the Cray 2 weighs 
5500 pounds and occupies 16 square feet of floor space. The 
Cray 2 had a Unix-based operating system, running at 260 Mhz, 
with about 2 GB of common RAM. The computer incorporated 
up to 336 pluggable processor modules, each of which contained 

Figure 1. The Cray 2 
Supercomputer took up the best 
part of a room. Here, you can 
see the processing unit in the 
foreground, and the cooling unit 
in the background.

Figure 2. Here is a detailed list of the physical characteristics of the 
Cray 2.

Physical characteristics
•• Occupies 16 sq. ft. of floor space
•• Stands 45 inches high; diameter is 53 inches
•• Weighs 5500 pounds
•• 14 columns arranged in a 300º arc
•• Liquid immersion cooling
•• Uses 16-gate array logic chips
•• Three-dimensional modules
•• Up to 336 pluggable modules
•• Up to 195 KW power consumption
•• 400 Hz power from motor generators
•• Chilled water heat exchange

http://en.wikipedia.org/wiki/Computer
http://www.wap.org
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approximately 750 integrated circuit (IC) packages. The total 
number of ICs could be as much as 240,000 chips. Each module 
measured 1x4x8 inches (see Figure 3), weighed about 2 pounds, 
and consumed 300 to 500 watts of power. In fact, the Cray 
engineers developed a special inert fluorocarbon fluid to cool the 
processor stacks.

The Cray 2 was intended to solve problems in many areas of 
science, engineering, and mathematical modeling. Applications 
included such diverse tasks as weather forecasting and economic 
modeling. You can see a more exhaustive list of the available 
applications of the time in Figure 4.

The iPad 2, by contrast, has external dimensions of 0.34x7.31x9.5 
inches, and weighs 1.33 pounds. It achieves its operating prowess 
using a single, dual core A5 system chip, operating at 1 Ghz. The 
power consumption is about 10 watts. The memory capacity of 
the iPad 2 is 16, 32, or 64 GB. 

The uses of the iPad 2 are, in a real sense, limited only by the 
imagination of the user. General-purpose uses include Web 
browsing, using email or social networks, watching videos, 
playing games, or business and enterprise applications.

It’s About the State of the Art
While the raw speed measure of the iPad 2 processor is 
impressive when compared to the Cray 2, the more salient point 
is the vast advance in computer technology over 25 years. This 
technology enabled such performance in a portable device that 
is orders of magnitude smaller than the Cray 2 in size, weight, 
and power consumption. The complete iPad 2 is smaller in size 
and weight than one of the Cray 2’s 336 processor modules. The 

Cray 2 required a dedicated computer center and an attendant 
staff to operate and maintain it. The iPad 2 is truly portable and, 
with its wi-fi and 3G connectivity, able to draw on vast resources 
of information. Certainly, the iPad 2 is not to be confused with 
a supercomputer in applications and throughput. But it could 
be considered to occupy as important a space in its part of the 
modern computer environment as the Cray 2 did in 1985.

When the iPad 3 comes out, we’ll have to see how it stacks up 
to today’s fastest computer in the world – the Chinese Tianhe-
1A (“Milky Way”). It operates at a speed of 2.1 petaFLOPS, which 
is a million times faster than a GFLOP. Is Apple ready for the 
challenge?

Figure 3 (left). Each of the 
Cray 2’s processing modules is 
about the same size as the iPad 
— but there could be as many as 
336 of them.

Figure 4 (right). This list of 
available applications for the 
Cray 2 gives you an idea of that 
computer’s capabilities.

Hardware Review

Applications
•• Fluid dynamics
•• Circuit simulation and design
•• Structural analysis
•• Energy research
•• Weather forecasting
•• Atmospheric and oceanic research
•• Quantum chemistry
•• Artificial intelligence
•• Genetic engineering
•• Signal image processing
•• Molecular dynamics
•• Petroleum exploration and extraction
•• Process design
•• Economic modeling

http://www.wap.org


21 of 35

Washington Apple Pi

Journal May – June 2011

Software Tutorial

How Tasty is Delicious Library 2?
by Jay Castillo

For several years I have considered creating an inventory 
of my modest book collection. I reviewed various 
applications, but they were essentially spreadsheets, 

requiring copious data input. This was quite enough to discourage 
me, for I am not a database person. However, at the WAP March 
General Meeting, Dr. Larry Kerschberg gave a presentation entitled 

“Your Digital Life, Part I.” Among other things, he demonstrated 
how to catalog books, music CDs and iTunes music, using the 
application Delicious Library 2. This software has one feature that 
immediately sold me on it: it uses a Mac’s built-in iSight camera to 
scan in the book’s ISBN and import all of the book’s data.  
I immediately bought a copy, and here’s what I learned.

Overview
The developer, Delicious Monster, says on its Web site  
(http://www.delicious-monster.com/) that the purpose of the 
application is to "[c]atalog your books, movies, music, software, 
toys, tools, electronics, & video games.” Essentially, if these 
objects have ISBN or UPC codes expressed as barcodes, they can 
be scanned into the library. The computer must be connected 
to the Internet in order for the application to fetch the object’s 
information. There is also manual input, but more about that later.

The user interface for Delicious Library 2 is the familiar bookshelf 
used in Apple’s iBook (Figure 1). You can click on the camera 
symbol or the plus symbol on the bottom left corner of the 
window, or click File>New Item on the Menu Bar, to start input 
functions. At the top of the open window on the bookshelf, select 
Book, Movie, Album, Software, Video Game, Toy, Gadget, Tool, 
or Apparel. When an object is selected, its category is displayed 
in the Library section at the top of the Shelves pane on the left 
of the bookcase. Present the object’s bar code to the camera 
window, placing it within the green reticle marks. The position 
may have to be adjusted a bit. There is an audible signal if the 
scan is successful, as well as a Preferences option to have the title 
spoken. If the scan is unsuccessful, an error message appears, 
and the manual input option is offered. You can display objects 
as images on the shelves or as a list. At the top of the bookcase, 

Figure 1: Delicious Library 2 
basic user interface.

http://www.delicious-monster.com/
http://www.wap.org


22 of 35

Washington Apple Pi

Journal May – June 2011

a flip button displays the categories possible for arranging the 
books — for instance, “creator” (Figure 2).

The application allows the creation of a list of friends from a 
contact List. The friends will appear at the bottom of the Shelves 
pane. With this, the user can keep track of who has borrowed 
stuff. You can even create a due date in your calendar.

Creating my book library
All books entered into Delicious Library 2 are consolidated under 
the Books library, but I wanted to classify my books by general 
subject matter. I could have put in all my books and then created 
a shelf for each book category, clicking and dragging the book 
cover to the appropriate shelf (see Figure 2). I chose instead to 
create the category bookshelves as I scanned in my books. They 
would appear in the library grouping anyway, so I thought it was 
more efficient.

 As I scanned in my books, I discovered some things that the 
developers didn’t tell me. If the books come from a retail store, 
like Borders, the barcode sticker on the back cover is usually the 
store’s inventory control code, not the ISBN. I had to peel off 
this sticker to reveal the ISBN beneath it. After figuring this out, 
I made progress fairly smoothly. When a book wouldn’t scan, 
particularly for books published before the late 1990’s, I typed the 
ISBN in the text window (Figure 1) and clicked “Find Book.” This 
usually worked. (Note that it isn’t necessary to type in the dashes 
of the ISBN). For older books without ISBNs, I had to enter the 
creator, title, or keyword. I discovered that it was much better to 
enter the author’s name than the title. The search function is not 
very discriminating and produces as many as 60 results. At least 
with the author option, I achieved a hit every time.

I did encounter an interesting peculiarity. I have a number of 
science fiction, mystery, and spy paperbacks published between 
the 1960’s and 1990’s. When I scanned the back cover ISBN (if 
it had one), I would receive information on a totally different 
book, or even a different object, such as a music CD. However, I 
discovered that most of these books also had an ISBN on the inside 
of the front cover. If I scanned this one, I got the correct results! 

Finally, if I got no results for a book, the last resort was to click 
on “Add Blank Book” in the manual input window (Figure 1). The 
Details sidebar pops up, and I could put in as much information 
as I cared to there (Figure 3). I note though that I entered over 

Figure 2: Book library with 
options for sorting.

Software Tutorial
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600 books into my library, and needed to 
create only a few blank books. You can also 
search for the cover art, but I was unsuccessful 
in importing those into Delicious Library 2.

Since my library is spread over two floors 
of my house, and I was scanning the books 
on my iMac in my office, I did quite a bit of 
stair climbing. Delicious Monster offers a 
Bluetooth IR scanner for $150. It operates 
over a 50-foot range from the computer, 
and the audio preference reports whether 
or not it’s working. If the scanner is out of 
range, it stores up to 4000 items that can be 
wirelessly transferred to the computer later. 

Using Delicious Library 2 for Music
Scanning CDs into my library turned out to be 
easy. Each CD jewel box had a UPC bar code, 
and the process was the same as for books, 
except that you need to select the country 
in which the CD was produced from the list 
on the input screen before clicking “ Find 
Album.” Figure 5 shows the list of countries in 
the input screen.

The CDs entered into Delicious Library 2 are 
displayed in the “Music” heading under the 
library section of the Shelves pane. They are 
also displayed in the main library category, 
mixed in with the books. I chose to create 
only two CD shelves, “Classical” and “Genre.”

Delicious Library 2 also has an option in 
Preferences entitled “Subscribe to My iTunes 
Library.” If you select this, an iTunes section 
appears in the Shelves pane and Delicious 

Software Tutorial

Figure 3 (Left): If the application cannot retrieve information for your book,  
you can enter it manually.

Figure 4 (Above): iTunes library contents are displayed as album covers.
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Library 2 will import iTunes albums. (See Figure 4.) Make sure to update 
album cover art in iTunes before doing this. There were still blank album 
covers in my collection even after I imported. Double-clicking on the 
album cover causes a “play“ button to display. Clicking on it opens iTunes, 
and the first (or only) song from that album will play.

Delicious Library 2 will also import any audio books or movies from 
iTunes. These categories will also show up under iTunes in the Shelves 
pane.

Pushing The Envelope
After completing (most of) my book cataloging, I was curious to see how 
the application handled other types of objects. I had just received my 
new iPad 2, and had ordered a carrying bag. When it arrived, I decided 
to see if it could be cataloged in Delicious Library 2. I cut off the tag with 
the UPC and scanned it under the “Gadget” category. And, mirabile dictu, 
there it was! In Figure 6 the bag image is displayed on industrial steel 
shelving, very appropriate for gadgets.

In a fit of delirium, I decided to scan a jar of peanut butter, wondering if I 
could inventory my pantry. It didn’t work.

A quirky thing occurred when I enabled animations in Preferences. When 
I deleted a book from a shelf, it burst into flame. Spare me from book 
burnings! When a CD or other object is deleted, it shatters into fragments. 

Figure 5: When searching for music information, select the country of origin for the album. 

Figure 6: Gadgets are displayed on industrial steel shelving.

Software Tutorial

http://www.wap.org


25 of 35

Washington Apple Pi

Journal May – June 2011

Exporting and Sharing
Having created a catalog of valued objects, Delicious Library 2 
enables the user to export or share these collections. First, create 
a list view of the desired collection. The choices to create are an 
XML file, a bibliography in standard format, a specialized file for 
the Bookends application, a rich text Delimited Text, and an Excel 
spreadsheet. Then open the export function window by clicking 
File>Export>Export to Another Application. I tested the Excel 
export, and it worked properly.

To share a collection, go to File>Publishing Setup. One can 
publish to a MobileMe account, an FTP site, or a folder on 
a computer, with the choice of publishing all or some of 
the collection, with one of two formats, paper stencil or 
shelves. I published my book collection to my MobileMe 
site. I then selected File>Visit Published Site, and got to 
the Web page shown in Figure 7. I like the result.

Conclusions
Overall, I recommend this application. Delicious Library 2 allowed 
me to do what I needed to do. The user interface is attractive 
and intuitive enough so that I could eventually figure out how 
things work. On the other hand, the Help function and developer 
website were not very useful. If one has large collections, it’s a lot 
of work to get started (but easy to keep up after that). I don’t like 
that the shelves are intermixed regardless of category of object. 
I would prefer that bookshelves be displayed under the Book 
library category, and similarly for each other category.

Figure 7: My Book library, published as a paper stencil to MobileMe for sharing.

Delicious Library 2 is a product of Delicious Monster  
(http://www.delicious-monster.com/).  

It is available from the developer for $35, or from 
the Apple App Store.
 

Software Tutorial

http://www.delicious-monster.com/
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Tips & Tricks

More about appearance settings, editing  
Address Book groups, batch tagging faces  
in iPhoto, and more… 

Back for more lesser-known hints? Hopefully, the four tips 
offered below will find their way into your computing 
bag of tricks. Read on.

1. Enlarging the iTunes window
Remember in the last Journal the tip about using the three 
colored window adjustment buttons, and how the green button 

was useful in expanding an application window to full screen? 
Well, one of our readers pointed out that this doesn’t work in 
iTunes; rather, that button turns the existing window into a mini-
player view. Go figure.

You can get iTunes to fill the whole screen by brute force, by 
positioning the iTunes window at the extreme top left corner of the 
screen and then dragging the bottom right corner to the opposite 
corner. This is crude, but it works. A better way is to go to the iTunes 
menu and select Window/Zoom, or (as indicated in that menu 
selection) use the keystrokes of Control - Command - Z (⌃⌘Z). Even 
simpler still: just hold the Option key (⌥) as you click the green 
maximize button. Voila, iTunes at full screen! (See Figure 1.)

2. Editing Address Book groups
Using groups in Address Book is a good thing. This feature allows 
you to gather a number of contacts into a group that in turn can 
be used as a single email “addressee” in Apple Mail. Only the 
group name will be displayed in the address block, unless you 
change the default setting in Mail preferences. Keeping the group 
members’ email addresses hidden protects the members’ privacy 
and protects them against ending up in some spam list. But that 
group name as an address can also present a problem for you.

What happens when a member of a group has more than one 
email account? Which address will the email go to and is it the 
best one for that person? There is a way to check which email 
address will be used and to adjust the selection. It all starts and 
ends in Address Book.

Pick an Address Book group that you need to check and right 
or Control click on it. As shown in Figure 2, the contextual or 

Do you have some 
favorite time-saving 
steps or favorite 
computing steps? 
Share them with the 
Journal editors via 
feedback@wap.org 
and we will publish 
them for others  
to use.

Figure 1 (top). In iTunes 
selecting the green maximize 
button does the opposite. The 
button minimizes iTunes to a 
mini-player view. Holding the 
Option key when clicking the 
green button will expand iTunes 
to full screen.

Figure 2. Here are the 
dropdown options available when 
right clicking on an Address 
Book group. Select the ‘Edit 
Distribution List’ and a new 
window will open showing all the 
email addresses for everyone in 
the group.

http://www.wap.org
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dropdown menu contains an option to ‘Edit Distribution List.’ This 
will open a new window with the entire list of contacts and every 
one of their email addresses. The one that is in dark print is the 
one the email will go to. The other addresses are shown but are 
grayed out. If you want a different email address than the one 
that Address Book selected, just click on it, and it will become the 
email address of choice. (See Figure 3.)

3. Batch tagging photos using Faces
iPhoto ’09 introduced the Faces feature and the latest version of 
the program, iPhoto ’11, retains it. Using Faces can be a tedious 
process though. Once Faces identifies the correct person, you have 
to accept or reject every image it identifies, and because Faces does 
such a great job of face recognition, there are usually pages and 
pages of photos to ‘Confirm.’ Instead of confirming each one by 
clicking the photo, click in an empty space near the corner of the 
Confirm Faces page and drag through all the photos that need to 
be reviewed. Every photo now sports the name of the person you 
are identifying, including any incorrect ones. Because Faces is so 
accurate, it is easier and quicker to reject the ones that are wrong 
than it is to confirm the ones that are correct. When you are done, 
click the Done button and you are off to the next person.

4. Mobile Safari: A faster way to open a new Web page
If you are using an iPad, iPhone, or iPod touch, you know the 
process of loading a URL in a new Safari page can be slow and 
cumbersome. First you launch Safari and wait for the app to 
open. Then the last Web page you loaded comes up. Next you 
need to tap the Pages button and press the New Page button. 
When the new page comes up you can finally enter the URL. 
Whew.

To simplify this process, just add a new icon that goes directly to a 
blank page. Here’s how to do it. Open a new Web page In Safari, 
and type “about:blank” in the address block. Click on the Utilities 
button, select the Add to Home Screen option, and give the page 
a title like “Blank Page.” Next time you want to go to a new URL, 

you need only tap on the blank page icon and it will launch Safari 
(if it isn’t running) and bring up a blank page. [Note: Don’t use 
more than 12 characters to name this page; if you do it the name 
will be truncated.]

Here’s another related tip. In Mobile Safari, to change a URL in 
the address field, there’s no need to first tap the ‘X’ at the right 
of the address field to clear the existing URL. Instead, just begin 
typing when the keyboard appears and Safari will automatically 
overwrite the existing address. (See Figure 4, next page.)

Figure 3. The Distribution List window allows you to see all the 
email addresses of everyone in an Address Book group. Clicking on a 
grayed-out email address will make that the address of choice. 
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Figure 4. These are multiple screen shots from an iPhone that illustrate the more 
important steps in creating a shortcut that will launch a blank page in Safari. The 
screen shots show in sequence: (a) the Google opening page; (b) the screen after 
selecting the Pages button; (c) the results of tapping the New Page button; (d) the 
text ‘about:blank’ entered in the address field; (e) a blank Web page; and (f) your new 
‘Blank Page’ icon. 

Preparing for Lion:  
Find Your PowerPC Applications
Continued from page 18

The story will, of course, be different for different users. Microsoft Office 2004 is 
likely to be a serious stumbling block for many folks, who will reason that to move 
to Office 2008 will mean loss of Visual Basic, and that to move to Office 2011 will 
mean loss of good old-fashioned usability. (I’ve already told how I migrated out of 
Office as a mail program; see “Escape from Outlook 2011! [5],” 26 October 2010.)

I expect that this article will be just one in a series, as various TidBITS editors 
chime in with tales of their preparations for Lion compatibility. As we wait for 
the fateful day, I comfort myself with the thought that, if I really need it, I have 
an Intel-based Mac that can boot into Snow Leopard, a PowerPC-based Mac that 
can boot into Leopard and use Classic, and a couple of really old machines that 
can even boot into Mac OS 9 (not to mention SheepShaver). Lion’s roar can’t 
scare me!

Resources:

[1]: http://tidbits.com/resources/2011-05/System-Profiler-
applications.png

[2]: http://tidbits.com/article/10679

[3]: http://tidbits.com/article/11491

[4]: http://rixjoint.blogspot.com/2011/04/unplanned-obsolescence.
html

[5]: http://tidbits.com/article/11696

Tips & Tricks
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Pi Comic

パチンコ
Pachinko is a Japanese gaming device used 

for amusement and gambling. A pachinko 
machine resembles a vertical pinball machine, 

but with no flippers and a large number of 
relatively small balls. 

You are asking yourself, what has this got 
to do with anything? Well, turn the page!

http://www.wap.org
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Pi Comic

Doesn't he 

know its not on?

http://www.wap.org


31 of 35

Washington Apple Pi

Journal May – June 2011

Washington Apple Pi Meetings

As always, check the Pi Web site for additional, updated details on these meetings.

Your Digital Life — Part Three
June 4, 9:30 a.m. at George Mason University

Note: This is the May General Meeting. It had to be delayed one week, into June, 
due to a scheduling conflict with the University.

This General Meeting continues the theme Your Digital Life, with part three of the 
series. The Pi’s management believes that there is much more to this topic, and 
besides presentations at General Meetings, there will be other references to this 
theme in the Journal and elsewhere.

The meeting will feature two presenters: Travis Good and Bo Huttinger. They will 
discuss the Apple TV (2nd generation) and remote access to your Mac via iChat, 
Google Desktop’s remote access utility, and LogMeIn. There will also be the regular 
fare of Questions and Answers and Back to Basics. After a lunch from Subway, the 
Mobile Lifestyle Special Interest Group will convene for their monthly meeting.

The meeting will be held on the GMU campus in the Enterprise building, Room 
178. The Pi Web site has the schedule of events and a map of the campus showing 
parking and the meeting location.

http://www.wap.org/events/may2011/

Apple Rep Aaron Davis Presenting
June 25, 9:30 a.m. at George Mason University

Aaron Davis of Apple will be the featured speaker for this meeting and, if the 
timing is right, we should get a first look at the newest operating system for the 
Mac — Mac OS X 10.7 Lion. Aaron brings a wealth of experience and knowledge 
about all things Apple. He will be able to give us some updates on Apple’s latest 
hardware products and software releases even if Lion hasn’t been released.

The meeting will begin with a Question and Answer session, followed by a Back to 
Basics tutorial and a short session of club business. We will have our usual coffee 
break, and then the main presentation. A sandwich lunch will be served for those 
who are sticking around for the Mobile Lifestyle SIG, which begins immediately 
after the break.

The June meeting will be held at our usual location, the Enterprise building, Room 
178 on the George Mason University campus in Fairfax VA. The Pi Web site has 
the full agenda and a map showing how to get there. Check back closer to the 
meeting date for any updates or changes.

http://www.wap.org/events/june2011/

http://www.wap.org
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Members Helping Members
Dedicated volunteers are the lifeblood of the Pi. Whether it is installing a hard drive at a Clubhouse 
Saturday event, answering questions at a General Meeting, or placing advice on the TCS Forums, 
there are many ways to pitch in and help, depending on your interests and talents. Please consider 
making a commitment to ensure that the Pi remains a strong and viable club providing meaningful 
help to its members. All volunteer efforts are appreciated. Check out these areas where assistance is 
needed.

Featured Position – General Meeting Webcast Director
The Pi currently captures its General Meetings on videotape for future viewing by members 
who cannot attend the meetings. We are able to concurrently produce live Webcasts using the 
same camera, so members can see the meeting in real time over the Internet. This activity 
needs a dedicated person to oversee the technical and production aspects of the Webcast. 

The Webcast Director needs to make sure that the equipment is properly set up and 
functioning to put the video on the Pi’s Ustream Web page. This means monitoring the audio 
and video streaming production from start to finish to ensure that the online viewers are 
receiving satisfactory audio and good clear video of the proceedings. The Webcast Director 
will not be responsible for any other part of the General Meeting program; their focus will be 
exclusively on the Webcast production.

Any previous experience in TV or video production would be advantageous, but is not 
required. A basic understanding of video and audio equipment and how to connect them 
would be helpful, but the contracted cameraman has primary responsibility for equipment 
hookup. The Webcast Director needs to monitor the meeting presenters to ensure that they 
do not stray from predetermined stage positions, so they remain adequately illuminated 
during their presentation. The Webcast Director also needs to be available in case there 
is a technical or other problem that requires the presentation to be suspended until the 
videotaping can continue. A case in point: the Webcast Director will stop the action when the 
cameraman indicates that the tape needs to be changed.

If you are interested in helping out, with an eye to taking over this important position, contact 
Bob Jarecke at robert.jarecke @wap.org.

http://www.wap.org
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Journal Managing Editor

The Journal is a time-honored publication of the Washington 
Apple Pi and it is in need of someone to take over as 
Managing Editor. This person will also be a member of 
the Pi’s Publications Committee, which has oversight 
responsibility for all printed material and electronic messages 
that emanate from the Pi. The job is challenging, but very 
rewarding.

If you enjoy writing and want to help the Pi progress, this is 
the job for you. Apply within!

Contact the current Journal editor, Jay Castillo, at  
editor@wap.org with any questions or to express your 
interest.

iChat Help Volunteer
Apple’s iChat application offers a way for Pi members to help other members 
from the comfort of their own home. Interested? Read on.

iChat is an ideal means for direct communication using text, voice, video, or, in the last two 
versions of Mac OS X, screen sharing. With the Pi having commercial grade servers and server 
software, we now have the means to host our own iChat network. We are currently in testing, 
and early results are positive.

So what will Pi iChat Help volunteers do? Essentially, the task is like any other scenario in which 
you help members who have questions or problems, but instead of a face-to-face meeting, you 
have a virtual meeting using iChat software. What’s that? You don’t use iChat or haven’t even 
launched it yet? No problem, we will train you. We will also be providing guidance on how to 
deal with common issues, and on problem-solving techniques, and will supply a list of associate 
helpers who can help with particular issues. All you need to bring to the equation is your people 
skills and a genuine desire to help.

If you have even the slightest interest or any questions, contact the Management Committee 
Chair, Bob Jarecke, at robert.jarecke @wap.org.

General Meeting Manager

Our General Meeting programs need someone dedicated to the planning and managing of 
these important club events. The job includes coordinating meeting activities, making any 
necessary arrangements, and managing behind-the-scenes tasks. While it sounds like a job for 
Superman, that really is not the case. If you have juggled household duties or have been an 
office administrator, you have the skills. While another Pi manager emcees the meeting, you will 
be making him or her look good!

Because this activity needs to be approved by the Pi’s Management Committee, the volunteer 
will serve as an adjunct member of that committee. This volunteer opportunity is guaranteed to 
keep you busy, and when the meeting is completed and meeting equipment packed up, lunch 
is on the Pi. Send your inquires to robert.jarecke@wap.org, or contact office@wap.org to 
express interest and we’ll go from there.

http://www.wap.org
http://www.wap.org
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One more thing …

The PhotoGraphix and  
Afternoon Learners SIGs on Hiatus

Both the PhotoGraphix and 
Afternoon Learners Special 
Interest Groups are not 

going to meet during the summer. 
No, they haven’t run out of topics, 
but it is characteristic that most 
of the attendees have less time 
available to attend these events; 
therefore, the SIG leaders have 
decided on a hiatus for the three 
summer months.

As for the next set of meetings 
for the groups, the topics are 
not yet firmed up, but rumor has 
it they will be interesting and 
engaging. For instance, the After-
noon Learners group is batting 
around idea of having attendees 
present their favorite third-party 
application.

You can expect that the Photo-
Graphix SIG will resume meeting 
on Saturday, September 10 at Mac 
Business Solutions in Gaithersburg, 
MD, and the Afternoon Learners 
SIG will begin anew on Thursday, 
September 15 at the Pi Clubhouse 
in Rockville, MD. The start times 
are 10 a.m. and 1 p.m. respectively.

If you have an idea of something 
you would like to see presented 
or have something you would like 
to present, contact the SIG leaders 
listed below.

PhotoGraphix SIG: Cheryl Lavoie 
at cherzart@gmail.com

Afternoon Learners SIG: Len Adler 
at adlerleonard@gmail.com

http://www.wap.org
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